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1.     Safety precautions and measurement conditions
· Prior to mounting the profilometer onto the wheel, areas of contact of the side

supports with the wheel surface should be thoroughly cleaned from dirt.
· When mounting the module on the wheel, do not allow heavy shocks of its

support against the wheel.
· The output window of the profilometer and profilometer supports must be

carefully inspected and cleaned. 
· Do not use laser module in locations close to powerful light sources.

2.     CE сompliance
The profilometers have been developed for use in industry and meet the

requirements of the following Directives:
· EU directive 2014/30/EU. Electromagnetic compatibility (EMC).
· EU directive 2011/65/EU, “RoHS“ category 9.

3.     Laser safety
The profilometer makes use of an c.w. 660 (or 405) nm wavelength

semiconductor laser. The maximum output power is 1 mW. The device belongs to the 2
laser safety class according IEC/EN 60825-1:2014. The following warning label is placed
on the profilometer body:

The following safety measures should be taken while operating the profilometer:
· Do not target the laser beam to humans.
· Do not disassemble the sensor.
· Avoid staring into the laser beam.

4.     General information
The Laser Profilometer IKP-5 Series is employed for measurement 
·  wheel flange thickness, 
·  flange slope
·  flange height 
·  wheel wear parameters,  
·  rim/tire thickness and width.
· Taking full profile of the wheel rolling surface.
· Maintaining the wheel wear database (computer software is available on the

website for free download)
· Tolerance control and sorting when checking, inspecting, repairing and forming

railway wheelsets.
Measurements are made directly on the rolling stock without rolling out the

wheelset.
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5.     Operation principle
Operator mounts the laser scanning module onto the wheel to be measured.

Having received a command from PDA or PC, the laser module performs non-contact
scanning of the wheel surface. Measurement results (geometric parameters and profile
of the surface) are displayed on PDA, can be saved in the PDA memory, and transferred
to the PC database. Simultaneously, additional parameters can be saved: operator
number, side identifier (left or right wheel), axis number, locomotive (carriage) number,
wheel set number, etc.

Hereinafter, PDA refers to an Android device (smartphone or tablet).
Video demonstration: https://riftek.com/eng/products/~show/instruments/railway-

devices/railway-wheel-profile-gauge-ikp

6.     Basic technical data

Name of parameter Value

Measurement range  

Flange height, mm
Flange thickness, mm
Flange slope, mm
Rim thickness, mm
Diameter (calculation method), mm

20…45
20…50
1…15

36…100 (30...90)
400…1400

Measurement error

Flange height, mm
Flange thickness, mm
Flange slope, mm
Rim thickness, mm
Diameter, mm

± 0,1
± 0,1
± 0,2
± 0,1
± 0,1

Discreteness of indication, all parameters, mm 0.01

Profile measurement range, mm 145

Discreteness of the profile formation, not worse than, mm 0.03 (5800 points for profile)

Dimensions of laser scanning module, mm see Fig. 5

Measurement time, s adaptive, depending on surface quality,
4 average

Power supply (laser scanning module) 3.7V
Li-ion rechargeable battery

5400mAh for standard IKP and
2400mAh for Short and Super-short

The number of measurements that can be taken before
battery recharge is not less than

5000

Laser module battery life time 5 million measurement cycles

Power supply (PDA) 3.7V
Li-ion battery
10000mAh

PDA memory capacity 100 000 measurements

PDA dimensions, mm 193х90х25

PDA display size 6.23"

PDA display resolution 1080x2280

Interface between laser scanning module and PDA Bluetooth

Interface between PDA and PC Wi-Fi

Working temperature range, °С -20…+50

Enclosure rating IP42 or IP64

https://riftek.com/eng/products/~show/instruments/railway-devices/railway-wheel-profile-gauge-ikp
https://riftek.com/eng/products/~show/instruments/railway-devices/railway-wheel-profile-gauge-ikp
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7.     Complete set to be supplied

Designation Name Quantity Weight,
kg

RF303S Digital readout device (PDA)* 1 0.42

RF505 Laser scanning module 1 0.8

RF505.40 Charging device 5V 1.0A for laser module 1 0.2

RF505.41 Charging device 5V 2.0A for PDA 1 0.2

RF505.42 Data cable 1

RF505.43 Bluetooth adapter 1

RF505.30 Case 1 1.2

RF505UM User Manual 1

Calibration tools (option):

RF505.11 Calibration block 4

RF505Calibr Calibration software is available on the website for free
download 

*It is possible to supply the instrment without a PDA, in this case, to work with
the instrument you will need an Android device (smartphone, tablet) with software (paid
license), which can be downloaded from the website:

https://riftek.com/upload/medialibrary/6a7/guqo45qzqyen9az3ds1no6yw8nj6m77
2/ikp.zip

Software for maintaining an electronic database on wheel sets wear is available
on the website for free download:

https://riftek.com/upload/iblock/760/Ikp5_PC_Software.zip

The profilometer comes in a special case
that protects the equipment against any
possible damage during transportation.

https://riftek.com/upload/medialibrary/6a7/guqo45qzqyen9az3ds1no6yw8nj6m772/ikp.zip
https://riftek.com/upload/medialibrary/6a7/guqo45qzqyen9az3ds1no6yw8nj6m772/ikp.zip
https://riftek.com/upload/iblock/760/Ikp5_PC_Software.zip
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7.1.     Android App licensing

The PDA supports work with three devices, namely IKP-5 (laser profiler of the
tread surface of a wheel pair), IDK-BT (the gauge for measuring the diameter of a wheel
sets) and IMR (back-to-back distance meter). By default, the PDA is configured to work
with the IKP, IDK-BT and IMR devices with which it is supplied.

One software license allows you to connect one set of devices (IKP, IDK-BT and
IMR) to the PDA.

One PDA can support an unlimited number of licenses to work with an unlimited
number of instrument sets.

One license can be installed on an unlimited number of PDAs.

8.     Device structure

8.1.     Basic components of the device and their functions

Figure 1 shows basic components of the device (chargers are not shown):

Figure 1

Figure 1 indicates: 1 - PDA, 2 - Laser scanning module, 3 - Calibration block.

8.1.1.     PDA

PDA is intended for control of the laser scanning module, data reception from
the scanning module, indication of measurement results, parameters input and data
storage.

Figure 2
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Figure 2 indicates:
1 - Turn On button
2 - Charger connection

8.1.2.     Laser scanning module

The module is intended for laser scanning of the wheel surface.

Figure 3

Figure 3 indicates:
1 - Turn On button
2 - Indicator of turn on (red LED)
3 - Indicator of Bluetooth connection (blue LED)
4 - Charging device connector 
5 - Support for mounting of the device on the wheel flange
6 - Magnetic support for mounting on the wheel side surface
7 - Charging indication, red/green LED
8 - Output window
9 - Rim measurement rod

8.1.2.1.     Laser module options

The figures below show versions of the laser module, differing in the scanning
range and the size of the handle for mounting the module on the wheel.

Standard option:
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Standard T option (with rim measurement rod):
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Short option:

SShort option:

SShort-BT option (with external battery):
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Battery for SShort-BT module:

8.1.3.     Calibration block

Calibration block is intended for calibration and tests of the profilometer.
Calibration block is a metal imitator of the part of wheel with a definite profile.

Overall dimensions of calibration block are shown in Figure 1A in Annex 3. Also
possible is supply of a unit with a profile made to the customer’s drawings.
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9.     Example of designation when ordering
IKP-V-М-S-T-R-L-PDA

Symbol Description

V Profilometer version:
without symbol - Standard version.
Short - Short handle.
SShort - Super short handle.
SShort-EB - Super short handle and external battery.

M Options of the set of magnets for mounting on the internal/external rim face:
S – Standard. Standard magnets (specified by default).
F – Forced. Reinforced magnets.

S Options of the support plates embodiment:
D – Direct. Standard plates, profilometer is mounted on the internal rim face (specified
by default).
I – Invert. Custom plates, profilometer is mounted on the external rim face.

T Presence of the rim measurement rod.

R Enclosure rating:
without symbol - IP42.
64 - IP64.

L Measured Rim width (scanning range). Possible ranges are shown on the pictures of
scanning module. Customized ranges are possible.

PDA Presence of PDA.

Example: 
IKP-Т-PDA  – standard laser module, standard magnets; standard support

plates; presence of the rim measurement rod, with PDA.
IKP-F-I – standard laser module, reinforced magnets; custom support plates,

without PDA.
IKP-Short-T-135 – shorten handle; presence of the rim measurement rod, 135

mm scanning length, without PDA.

10.     Geometric parameters of the wheel under control
Geometric parameters of the wheel are calculated automatically after laser

scanning of the wheel is completed. To calculate geometric parameters, use is made of
reference points on the wheel profile. Location of the reference points is defined by L-
and P-parameters. Values of L- and P-parameters preset in PDA are given in paragraph
14.4. and can be changed by the user.

10.1.     Flange height, sH

Calculation of the flange height is determined by parameter L2.
The flange height is calculated as a distance measured vertically between the

flange top and the point of wheel rolling surface at any preselected distance (L2) away
from the inner face of the wheel tire.
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10.2.     Flange thickness, sD

Calculation of the flange thickness is determined by parameter L3 that specifies
Point 1 on the flange surface. There are two ways to specify the parameter:

Method 1

Height L3 is measured vertically
upward from a point of the wheel
rolling surface, the position of
which is defined by parameter L2.

Method 2

Height L3 is measured vertically
downward from the flange top.

The flange thickness is calculated as a distance measured horizontally at any
preselected height (L3) between two points (Point 1 and Point 2) lying on the opposite
sides of the flange top.

There are two ways to calculate the flange thickness:

Method 1

Point 1 is defined by parameter L3.
Point 2 is the intersection point of a
horizontal line and a line lying on the
internal face of the wheel.

Method 2

Point 1 is defined by parameter L3.
Point 2 is the intersection point of a
horizontal line and the flange surface.

Note: Both calculation methods can be performed simultaneously.

10.3.     Flange slope, qR

Calculation of the flange slope is determined by parameters L1 and L3 (or L4).

Height L1 is measured vertically downward from the
flange top and determines Point 3 on the flange
surface.
Height L4 is measured vertically upward from a point
of the wheel rolling surface, the position of which is
defined by parameter L2 (wheel rolling circle), and
determines Point 4 on the flange surface.
Height L3 is described in paragraph 10.2.

There are three ways to calculate the flange slope:
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Method 1
Calculation in millimeters

The flange slope is calculated as a
distance measured horizontally
between Point 3 and Point 1 (or 4). the
The PDA screen displays information
in millimeters.

Method 2
Calculation in degrees

The slope is calculated as the
inclination angle of a straight line
passing through Point 1 or 4. 
The PDA screen displays information
in degrees.

Method 3
Pass/Fail

The calculation is performed
according to Method 1.
The PDA screen displays information
only about whether the measured
slope meets the tolerance conditions
or not.

10.4.     Wear parameters

The following wear parameters are calculated automatically:

Vertical wear  Wt is calculated as the difference between the measured flange height and the
flange height of the selected reference.

Horizontal wear  Wf is calculated as the difference between the measured flange thickness and the
flange thickness of the selected reference at height L3.

Corner wear  Wr is calculated as the distance along the normal to the tangent at the point at
height L5 from the wheel rolling circle of the measured profile, and the selected
reference.

* Red color indicates the worn profile 

Hollow Hl is calculated as the difference between the maximum and minimum values
within the specified limits. 
The search limits: parameters P7...P8.
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Difference of
diameters

dD is calculated as the difference between diameter at point D1 and diameter at
point D2. 

Even wear  W1 is the maximum vertical wheel wear selected from several measurements.

Uneven wear W2 is the difference between the maximum wheel wear and the minimum wheel
wear (selected from several measurements).

10.5.     Angle parameters

The following profile parameters are calculated automatically:

Inclination A is calculated as the profile inclination angle (in degrees) at a point with
coordinate L8.

Angle 1 S1 is calculated as the inclination angle of the straight line (in percents) passing
through points on the wheel surface located at preset distance L6 from the
wheel face and the distance L6+10mm from the wheel face.

Angle 2 S2 is calculated as the inclination angle of the straight line (in percents) passing
through points on the wheel surface located at preset distance L7 from the
wheel face and the distance L7+10mm from the wheel face.

10.6.     Rim parameters

The following rim parameters are calculated automatically:

Rim width L is calculated as a distance measured vertically between the internal and
the external basic wheel surface.

Rim thickness sT is calculated as a distance measured vertically between the internal rim
diameter and a point on the wheel rolling circle located on any preset
distance L2 away from the wheel face.

L11 is an external wheel diameter.
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10.7.     Wheel diameter

Diameter D is calculated by the formula:
D = 2*T +L10, 
T – rim thickness
L10 – diameter of the wheel center

10.8.     Tram wheel parameters

The following parameters of the tram wheels profile are calculated automatically:

Flange thickness sD15 is calculated as a distance measured horizontally at the set
height (L15) between two points: 1st point is at the internal
flange surface, 2nd point is at the line lying on the internal
face of the wheel surface.

Flange thickness Df is calculated as a distance measured horizontally at the set
height (L3) from the surface of the wheel rolling circle
between two points lying on opposite sides from the flange
top.

Reverse slope f is calculated as a distance measured horizontally from the
point on the internal flange side at the set height (L3) to the
point on the line lying on the internal face of the wheel. 

10.9.     Wheel defects

The following parameters of defects of the wheel surface are calculated:

Slide sP is calculated as a difference of the wear measurements in
two places of the wheel: on the slide and close to it (in the
place without defects) at the point on the wheel rolling circle
at any preset distance (L2) from the wheel face.

Cavity size hR is calculated as a difference of the wear measurements in
two places of the wheel: on the cavity and close to it (in the
place without defects) at any profile point.

Cavity area sR is calculated in the place of the maximum deviation.
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11.     Coordinate system
When comparing the profiles, two variants of location of the coordinate system

of the wheel is possible to use.

Coordinate system origin

Top
When comparing and displaying profiles, the
coordinate system origin is located at the
intersection point of lines passing through the
profile top and the internal wheel surface.

Wheel rolling circle
When comparing and displaying profiles, the
coordinate system origin is located at the
intersection point of lines passing through the
wheel rolling circle.

12.     Adding and selecting the measurement device
By default, the PDA is configured to work with the IKP, IDK-VT and IMR devices

with which it is supplied. To add a new device, you must follow the following instructions:

go to the Gauges menu, for which you need to press , or swipe your finger from the
left edge of the case to the center of the screen.

In the Gauges window, you can turn on/off Bluetooth, select the type of
measuring gauge (by default, IKP) and add a new measuring gauge depending on the
selected type. 

To add IKP, turn on the laser module and tap SCAN FOR DEVICES.
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On the first search, the app will ask you to access the device's location data. To
start the search, you need to tap ALLOW. 

If you tap DENY, device search will not be available and the following message
will be displayed: 

If the search is successful, the gauge will be added to the AVAILABLE
DEVICES list and then, for pairing, you need to tap on this device.
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The device will be paired, but locked for selection as the primary for
synchronization ( ). To unlock and select it as the main one, you need to swipe left from
the right edge and tap the Select button.

In the window that appears, enter the key to unlock the device or scan the QR
code. A unique key or QR code is supplied with the measuring gauge or upon request. If
the key is incorrect, an error message will appear.
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To scan a QR code, you must allow the app to take photos and videos.

If the correct key is entered, the lock icon will disappear and a check mark ( )
will appear next to the selected device. 
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The selected device will be connected automatically after starting the
application. 

If the required device is in the list (and unlocked), you just need to select it. 

 

If the measuring gauge is no longer in use, you can remove it from the list of
available devices by canceling the pairing. To do this, swipe left from the right edge and
tap the Delete button.

To add another measuring gauge (IDK, IMR), follow the same steps.
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13.     PDA program setting
Before you start working with gauges, you need to configure the software. To do

this, select the Parameters item in the main menu:

13.1.     Setting general parameters

Selecting General settings opens a window for setting up an Access password
and Bluetooth connection:
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13.1.1.     Setting a password

The Password settings section allows the user to set a password to access all
basic settings.

To set a password, select the Password item, enter the password and confirm
it. By default, the password is "1111". 
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13.1.2.     Bluetooth settings

Autoconnection - if this option is enabled, then at startup the application will try
to connect to the measurement device that is selected in the settings (see par. Adding
and selecting the measurement device). 

If this option is disabled, then you must tap on the synchronization icon in the
main program window in order to establish a connection to the device. 

Turn on Bluetooth - if this option is enabled, then at startup the application will
automatically check if Bluetooth is enabled, and if not, enable it. 
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If this option is disabled, it will be necessary to manually enable Bluetooth each
time you start the app in order to connect to the measuring gauge. 

Turn on confirmation - this option becomes available only if the Turn on
Bluetooth option is selected. If the option is enabled, the app will ask for confirmation to
turn on Bluetooth. 

13.1.3.     Change the program language

Changing the program language is performed upon request to the manufacturer
(info@riftek.com) and is a free service. 

13.2.     Setting general measurement parameters

Selecting the Measurement item opens a window for setting measurement
parameters.

mailto:info@riftek.com
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Measurement type - see the next chapter
Units  - select mm/inch.
Inverted measurement - if this option is selected, the profilometer is installed on

the outer base surface of the wheel during measurement.
Rim thickness measurement mode - if this option is selected, the profilometer

allows you to measure the thickness of the rim when installed on the inner surface of the
wheel in the 90° position

Filtering of spikes- if this option is selected, additional data filtering is
introduced during measurement to smooth out the dents on the wheel surface.

Display graph - this option allows you to display an image of the measured
wheel profile.

13.2.1.     Setting the measurement type

To set the measurement type, tap the Measure type item and select Rapid
measurement or Measurement by scheme.
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13.3.     Setting up data export

Selecting the Data export settings item opens a window for setting options for
exporting saved data:

13.3.1.     Export to PDA

To enable the ability to save a data file on your PDA, you need to set the Save
to smartphone option.

Next you need to select the file format (CSV, XLS, XML,WHL).
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13.3.2.     Export to PC data base

To enable the ability to export data, set the External local database option

To transfer data between a PDA and a PC, you need to configure the IP address
of the PC. Data exchange is carried out via Wi-Fi. The PC and PDA must be connected
to the same Wi-Fi network. This can be a dedicated network created on an Android
device (virtual hotspot) or any home/work network.
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13.3.2.1.     PC server settings

To transfer data to a PC, you need to specify the port and IP address of the
server that is running in the Ikp5_DB program (download link: 
https://riftek.com/upload/iblock/f57/Ikp5_PC_Software.zip).

The IP address can be found on the PC. There are two ways to find your IP
address on Windows.

Method 1. Find the IP address using the Settings app (Windows 10).
1. Select Start > Settings.

2. Select Network & Internet.

https://riftek.com/upload/iblock/f57/Ikp5_PC_Software.zip
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3. In the left panel, select Wi-Fi.

4. Click on your network name.
5. Scroll down to the IPv4 address - this is your IP address.

Method 2. Find the IP address using the command line. 
1. Click Start, type cmd in the search bar and press Enter.

2. Type ipconfig and press Enter.
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3. Find the IPv4 address - this is your IP address.

This IP address must be specified in the PC server settings. The port number is
the same as in the settings of the Ikp5_DB program on the PC (see Synchronization of
a mobile device and a PC).
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13.3.2.2.     PDA server settings

A server on PDA is needed to transfer reference files and processing scheme
files from the Ikp5_DB program. 

The IP address field is unavailable for editing, it displays the IP address of PDA
in the Wi-Fi network. This IP address is used in the settings of the Ikp5_DB program
(see Synchronization of a PDA and a PC).
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13.3.3.     Sending data by email

To enable the ability to send a data file via Email, check the Send email option.

To send data, you need to enter the recipient's address and select the format of
the sent file (CSV, XLS, XML, WHL).
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13.4.     Setting IKP measurement parameters

The menu item Measurement Parameter Settings is responsible for the
settings for calculating the controlled wheel parameters.

Calculation methods - setting up methods for calculating wheel sets
parameters.

Calculated parameters - selection of wheel set parameters for calculation and
display.

L parameters - setting the values of reference points for calculating the
parameters of wheel sets.
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13.4.1.     Calculation methods

Select the Calculation methods item:

Methods for calculating parameters are described in the previous paragraphs..

13.4.2.     Calculated parameters

Select the Calculated parameters item:

To select / deselect a parameter, tap the parameter.
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13.4.3.     L parameters

Select the L parameters item:

The table displays only those parameters that are necessary for calculating the
selected geometric parameters of the wheel (see par. Calculated parameters). 

To edit a parameter, tap on the parameter and enter a new value in the window
that appears. After entering, tap ОК. 
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13.4.4.     Preset values

L
parameter

Default
value

Assignment

L1 2 mm It is used to calculate the flange slope (qR).

L2 70 mm It sets the position of the wheel rolling circle and is used to calculate: 
- flange height (sH);
- flange thickness (sD);
- flange slope (qR);
- inclination angle (A);
- wheel diameter (D);
- rim thickness (T);
- wear (Wt, Wf, Wr). 

L3 13 mm It is used to calculate:
- flange thickness (sD);
- flange slope (qR);
- wear (Wf).

L4 13 mm Additional point for calculating the flange slope (qR).

L5 10 mm It is used to calculate the angular wear (Wr).

L6 70 mm It is used to calculate the slope of the rolling surface (S1).

L7 105 mm It is used to calculate the slope of the rolling surface (S2).

L8 10 mm It is used to measure the inclination angle of the profile at the desired point
(A).

L9 140 mm It is used when the measurement direction is inverted (L9 - profile width).

L10 599.35 mm It is used to calculate the profile diameter (D).

L11 767 mm It is used to calculate the rim thickness of the reference profile (T).

L15 13 mm It is used to calculate the flange thickness of tram wheels (sD15).

P7 
P8

70 mm
110 mm

It is used to calculate the hollow (Hl).

D1 
D2

70 mm
107.5 mm

It is used to calculate the difference in wheel diameters in different
sections (DD).
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14.     Setting reference profiles, measurement
schemes, tolerances

Swipe right from the left edge and select Tools.

Reference - selection of reference profile.
Scheme - measurement scheme settings.
Tolerance - tolerance settings.
Wheelset type - wheelset type settings.

14.1.     Reference profile

The program allows you to compare the scanned wheel profile with the reference
profile.
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14.1.1.     Selecting and deleting the reference profile

To select a reference as the main one, you need to swipe left from the right edge
and tap Select. The selected reference will be marked with .

To delete one reference, you need to swipe left from the right edge and tap
Delete.

To delete several or all references, you need to tap and hold the item. Multiple
selection mode will start. 
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Buttons:

 - delete the selected references;

 - select all.
To view the profile and reference parameters, you must tap on the required

item. 
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14.1.2.     Uploading the reference profile to the database

The app comes with several pre-installed reference profiles.
If the required reference profile is not in the database, the user can request

RIFTEK (free service) and then add the profile.
There are three ways to add a new reference to the database: 

1. Copy the reference file to the device (in any standard way) and tap . Select
the files you need and tap Select. 

2. Export a profile from the database of measured profiles (see par. Saving the
wheel profile as the reference).

3. Export the reference file from the Ikp5_DB program to a PC (see par.
Transferring the reference file).

14.2.     Measurement scheme

The measurement scheme is the sequence of measurements of the wheels of
the rolling stock with the given parameters of each wheelset (wheelset number, car
number, series, etc.). The program automatically prompts the operator to measure a
specific wheel in accordance with the selected scheme. The program contains several
pre-installed schemes.
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14.2.1.     Selecting and deleting the measurement scheme

To select a scheme as the main one, you need to swipe left from the right edge
and tap Select. The selected scheme will be marked with .

In the figure, the arrows show the direction of measuring the wheelsets, as well
as the names assigned to the wheels (1L - first axle, left side; 2L - second axle, left side;
1P - first axle, right side, etc.). 

To delete one scheme, you need to swipe left from the right edge and tap
Delete. 

To delete several or all schemes, you need to tap and hold the item. Multiple
selection mode will start. 
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Buttons:

 - delete the selected schemes;

 - select all.

14.2.2.     Uploading a new measurement scheme

The app comes with several pre-installed measurement schemes.
If the measurement scheme is not in the database, the user can generate the

scheme himself (see the User Manual for IKP) or request RIFTEK (free service) and
then add the scheme.

There are three ways to add a new measurement scheme to the database:
1. Create a new scheme yourself.

To do this, tap  and select Add from the drop-down menu.
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Enter the name of the scheme, the number of cars in the train, the number of
axles in each car, and the type of scheme. After entering all these data, tap .

 

2. Copy the scheme file(s) to the device (by any standard method), tap  and
select Import from the drop-down menu.

Tick the required files and tap Select.
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3. Export the scheme file(s) from the Ikp5_DB program to a PC (see par.

Transferring the scheme file).

14.3.     Tolerance

The app automatically controls the measured geometric parameters for going
beyond the specified tolerances.

14.3.1.     Viewing and deleting tolerances

For each reference profile, you can add the tolerances for the calculated
parameters of the wheelset. 

The screenshots below show the tolerances for the "Loco_33" and
"DMeTILR_33" references. If "Loco_33" is selected as the reference profile, the
tolerance will also be used with the name "Loco_33". 

To view or edit the values, you need to tap on the name of the tolerance.
The table displays the tolerances only for the selected geometric parameters of

the wheel. 
The maximum/minimum critical values of the parameters are displayed in red.

The maximum/minimum values of the parameters, which are close to the critical values,
are displayed in orange. 
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To delete a tolerance, you need to swipe left from the right edge and tap Delete,
or tap and hold the item with the tolerance name (the procedure is the same as for the
references - see par. Selecting and deleting the reference profile).

14.3.2.     Adding tolerances

To add a tolerance, tap  and select a reference for which the tolerance will be
set. 



IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

49

To set the tolerances for the calculated parameters of the wheelset, tap on the

tolerance name. Then tap  and select the parameter for which the tolerances will be
set. The drop-down list contains only those parameters that are selected for calculation
(see par. Calculated parameters).

After selecting a parameter, the limit values must be entered. 

To edit the tolerance, you can enter the desired value using the keyboard, or tap
on the field and, holding your finger, select the desired value.



50

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

To save the tolerances, tap . The added tolerances for the selected
parameter will be displayed in the list. 
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14.4.     Wheelset type

If different types of wheels must be measured, it is possible to set a specific
scheme, reference profile and parameters for each type. 

For instance, there are three types of wheels: WheelType1, WheelType2,
WheelType3. Each time you switch to a new type, you can change the parameters,
scheme and reference, or you can define these values for each type of wheel and, in the
future, select only the required type. 

An example:
WheelType1: Reference 1, Scheme 1, Parameters 1;
WheelType2: Reference 2, Scheme 2, Parameters 2;
WheelType3: Reference 3, Scheme 3, Parameters 3;

14.4.1.     Selecting and deleting the wheelset type

To select a type as the main one, you need to swipe left from the right edge and
tap Select. The selected type will be marked with .

To delete a type, you need to swipe left from the right edge and tap Delete, or
tap and hold the item with the type name (the procedure is the same as for the
references - see par. Selecting and deleting the reference profile).
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14.4.2.     Adding the wheelset type

The app comes with preset measurement parameters.

To add a new type of wheel, tap  and enter the name.

After adding a new type of wheelset, all settings contain standard preset values.
To set specific values, you need to edit the created type of wheelset, see par. Editing
the wheelset type.

14.4.3.     Editing the wheelset type

To edit the wheelset type, tap on the type name.
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To set the values:
· Select the Scheme.
· Select the Reference.
· Set the Calculation methods (see par. Calculation methods).
· Set the Calculated parameters (see par. Calculated parameters).
· Set the L parameters (see par. L parameters).

15.     Software update
The software version is shown in the About window. To open the About window,

tap  or swipe right from the left edge and select About.

To check if you have the latest version, tap the CHECK UPDATE button. If you
have the latest version installed, the app will display a corresponding message.
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If you do not have the latest version installed, you will be prompted to update the
application. Tap OK to update. The new version of the application will be downloaded
and installed automatically.

 

The latest version of the software can be downloaded at:
https://riftek.com/upload/medialibrary/a75/ikp.zip

The update procedure is the same as when installing the application.

https://riftek.com/upload/medialibrary/a75/ikp.zip
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16.     Measurement
There are two measurement types:
1. Rapid measurement (see par. Rapid measurement).
2. Measurement by scheme (see par. Measurement by scheme). 
How to select the measurement type – see par. Setting the measurement type or

par. Quick setup.

16.1.     Quick setup

The main window contains tools that allow the user to quickly configure
parameters.

Quick setup is not active if a password for changing parameters is set.

· To quickly select the type of measuring device, tap on the name of the current
device and make a selection.

· To quickly select the measurement type, tap on the current measurement type
 and make a selection.
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· To quickly select the measurement scheme (used when measuring according
to the scheme, see par. Measurement by scheme), tap on the current

measurement scheme  and make a selection.

· To quickly select the reference, tap on the current reference  and make a
selection.
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16.2.     IKP-5

To synchronize with the profilometer, you need to select IKP as the gauge type.
Selecting the type of measuring gauge – see par. Adding and selecting the
measurement device or par. Quick setup.

16.2.1.     Turning on the gauge

· Before first use, charge the laser module and PDA batteries by connecting
them to the charger.

· Turn on the laser module by pressing and holding the power button for a few
seconds. When turning on the laser module, the red LED flashes. 

· After turning on the laser module, the wireless connection between the module
and PDA will be automatically established (during this time, the blue LED is
on). Once the connection is established, the blue LED turns off. 

· The main program window will be updated: 
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All buttons and indicators become active.

16.2.2.     Installing the gauge on the wheel

Attention! 
Before installing the laser module on the wheel, you need to remove any dirt from the areas
where the laser scanning module will be in contact with the wheel surface.
When installing the laser module on the wheel, do not allow strong impacts of its supports
against the wheel, because this can lead to incorrect operation of the profilometer.

It is necessary to periodically inspect the output window and base supports of the laser module
and clean them of dirt. 
Do not clean glass with abrasive materials or aggressive cleaning agents.

To make measurements, follow these steps:
· Install the laser module on the calibration block or wheel - place the support of

the laser module on the wheel flange and press the magnetic support against
the inner edge of the wheel.

· For the rim measurement, extract the rim measurement rod and hitch it up to
the rim.
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· Make sure that the module is mounted correctly without any misalignment and
gaps.

16.2.3.     Rapid measurement

This measurement type is used to quickly measure parameters or to save a
single measurement to the database with the possibility of setting wheel identification
parameters.

Procedure:
· Tap the MEASUREMENT button. The application will ask for the calibration

parameters of the laser module and, in case of successful reading, the
Measurement window will appear. 

· When you tap the Measurement button, the laser module will scan the wheel
surface. The scanning time is about 1-2 seconds, during which the red LED is
on. 

· After completing the scanning process, the application will display the
measured parameters.
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When the value is outside the specified tolerance, it is highlighted in red
(orange):

· If necessary, tap the Measurement button to scan the wheel surface again. 
It is possible to display only the parameters of the measured profile. To do this,

clear the Reference profile checkbox. 
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· When scanning the calibration block or the reference wheel, the scan results
must differ from the nominal values by no more than 0.1 mm. In this case, the
device is ready for operation, otherwise it is necessary to calibrate the device
in accordance with the User Manual. 

· If the wheel was scanned once, tap  to save it and enter the wheel
identification parameters.

The measurement will be saved to the database (see par. Viewing measurement
results).
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16.2.4.     Measurement by scheme

This measurement type makes it possible to use all features of the profilometer,
such as working with the database of measurements. 

Procedure:
· Tap the Measurement button. The application will request the calibration

parameters of the laser module and, in case of successful reading, the Wheel
parameters window will appear. The values are displayed in accordance with
the selected measurement scheme. If necessary, the user can edit the
parameters.

· To save the parameters, tap . The application will display the selected
measurement scheme, as well as the values of the wheel parameters that are
selected for the calculation (see par. Calculated parameters).
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Editing the entered parameters of the wheelset.

 Moving to the previous/next wheel.

 Moving to the previous/next car.

The unmeasured wheel.

The wheel to be measured.

The measured wheel (within tolerance).

The measured wheel that will be measured again.

The measured wheel, the parameters of which are close to the critical values. 

The measured wheel, the parameters of which are outside the critical values.

Ordinal number of the car (displayed if there are several cars in the scheme)

· To measure the wheel suggested by the application (highlighted in green), tap
the MEASUREMENT button. The laser module will scan the wheel surface. 

· After scanning, the measured values of the wheel geometric parameters are
displayed on the screen. If a parameter is beyond the specified tolerance, its
value is highlighted in orange or red:
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It is possible to display only the parameters of the measured profile. To do this,
clear the Reference profile checkbox. 

· To repeat the measurement, tap the MEASUREMENT button.

· When a satisfactory result is obtained, tap  to save the data.
· The application will offer to measure the next wheel in accordance with the

measurement scheme.
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· Use the navigation arrows to view the results of the previous measurement. If
you select the measured wheel, the saved wheel parameters will be displayed. 

· When you select the measured wheel, the application will warn you that the
measurement with such parameters has already been saved in the database
and will offer to save the new measurement. 

All saved measurements will be saved to the database (see par. Viewing
measurement results).
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16.3.     IDK-BT

To synchronize with the wheel diameter measuring gauge, you need to select
IDK as the gauge type. Selecting the type of measuring gauge – see par. Adding and
selecting the measurement device or par. Quick setup.

16.3.1.     Turning on the gauge

· Before using for the first time, charge the batteries of the IDK by connecting
them to the charger.

· Press the Red button to turn on the gauge.

The display shows “ErrP” message if the battery voltage is below the control level. In this case,
short-term operation is possible after pressing any button.

· After turning on the gauge, a wireless connection is automatically being
established between the module and the mobile device (the blue LED is on).
Once the connection is established, the LED turns off.

· The main window will be updated:

 

The MEASUREMENT button and the Bluetooth connection indicator become
active.

16.3.2.     Installing the gauge on the wheel

To make a measurement, do the following:
· Place the gauge onto the wheel.
· Make sure the ball supports and the measuring tip of the gauge are tight

against the roll surface and side supports are adjacent to the edge of the
wheel.



IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

67

16.3.3.     Rapid measurement

This measurement type is used to quickly measure the diameter or to save a
single measurement to the database with the possibility of setting wheel identification
parameters.

Procedure:
· Tap the MEASUREMENT button. The application will ask for the calibration

parameters of the IDK and, in case of successful reading, the Measurement
window will appear. 

 - Measure the diameter.

 - Reset the averaging result (the display shows "-----").

· Press the Green button. After a second, the wheel diameter value will appear
on the display.

· When the diameter value exceeds the specified tolerance, its value is
highlighted in red:
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To continue measurements with averaging:
· Press the Green button.
· The IDK display will show the value of the “n     x” counter, where x is the

number of averaged measurements.
· After a second, the average value of the wheel diameter will be displayed.
· Install the gauge to a new position and repeat the measurements. The total

number of measurements averaged in this way can reach 9999.
· Press the Red button to reset the averaging result.

· To save the measurement, click  and enter the wheel identification
parameters.

The measurement will be saved to the database (see Viewing measurement
results).

16.3.4.     Measurement by scheme

This measurement type makes it possible to use all features of the gauge, such
as working with the database of measurements. 

Procedure:
· Tap the Measurement button. The application will request the parameters of

the IDK and, in case of successful reading, the Wheel parameters window will
appear. The values are displayed in accordance with the selected
measurement scheme. If necessary, the user can edit the parameters.
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· To save the parameters, tap . The application will display the selected
measurement scheme and diameter values.

Buttons assignment - see Measurement by scheme.
· To measure the wheel suggested by the application (highlighted in green), tap

the MEASUREMENT button. The application will display the Measurement
window and the IDK will measure the diameter. The measured wheel diameter
will be displayed.

When the diameter value exceeds the specified tolerance, the value is
highlighted in red:
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· To repeat the measurement, tap the MEASUREMENT button.

· When a satisfactory result is obtained, tap  to save the data.
· The application will offer to measure the next wheel in accordance with the

measurement scheme.

· Use the navigation arrows to view the results of the previous measurement. If
you select the measured wheel, the saved wheel diameter will be displayed. 
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· When you select the measured wheel, the application will warn you that the
measurement with such parameters has already been saved in the database
and will offer to save the new measurement instead of the existing one.

All saved measurements will be saved to the database (see par. Viewing
measurement results).
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16.4.     IMR

To synchronize with the back-to-back distance measuring gauge, you need to
select IMR as the gauge type. Selecting the type of measuring gauge – see par. Adding
and selecting the measurement device or par. Quick setup.

16.4.1.     Turning on the gauge

· Before using for the first time, charge the batteries of the IMR by connecting
them to the charger.

· Press the Red button to turn on the gauge.

The display shows “ErrP” message if the battery voltage is below the control level. In this case,
short-term operation is possible after pressing any button.

· After turning on the gauge, a wireless connection is automatically being
established between the module and the mobile device (the blue LED is on).
Once the connection is established, the LED turns off.

· The main window will be updated:

 

The MEASUREMENT button and the Bluetooth connection indicator become
active.

16.4.2.     Installing the gauge on the wheel

To make a measurement, do the following:
· Install the gauge on the inner surface of the wheel.
· Make sure the magnetic base is firmly attached to the surface.
To avoid hitting the gauge against the wheel, follow the instructions below:
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Place the gauge edge on the
wheel

Gently tilt the gauge Lock the gauge on the wheel

16.4.3.     Rapid measurement

This measurement type is used to quickly measure the back-to-back distance or
to save a single measurement to the database with the possibility of setting wheel
identification parameters.

Procedure:
· Tap the MEASUREMENT button. The application will ask for IMR parameters

and, in case of successful reading, the Measurement window will appear. 

 - Measure the back-to-back distance.

 - Reset the averaging result (the display shows "-----").

· Press the Green button. After a second, the measured value will appear on the
display.

· When the value exceeds the specified tolerance, it is highlighted in red:
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To continue measurements with averaging:
· Press the Green button.
· The display will show the value of the “n     x” counter, where x is the number

of averaged measurements.
· After a second, the average value of the back-to-back will be displayed.
· Install the gauge to a new position and repeat the measurements. The total

number of measurements averaged in this way can reach 9999.
· Press the Red button to reset the averaging result.

· To save the measurement, click  and enter the wheel identification
parameters.

The measurement will be saved to the database (see Viewing measurement
results).

16.4.4.     Measurement by scheme

This measurement type makes it possible to use all features of the gauge, such
as working with the database of measurements. 

Procedure:
· Tap the Measurement button. The application will request the parameters of

the IMR and, in case of successful reading, the Wheel parameters window will
appear. The values are displayed in accordance with the selected
measurement scheme. If necessary, the user can edit the parameters.
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· To save the parameters, tap . The application will display the selected
measurement scheme and back-to-back distance values.

Buttons assignment - see Measurement by scheme.
· To measure the back-to-back distance suggested by the application

(highlighted in green), tap the MEASUREMENT button. The application will
display the Measurement window and the IMR will perform the measurement.
The measured back-to-back distance will be displayed.

When the back-to-back distance value exceeds the specified tolerance, the
value is highlighted in red:
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· To repeat the measurement, tap the MEASUREMENT button.

· When a satisfactory result is obtained, tap  to save the data.
· The application will offer to measure the next wheel in accordance with the

measurement scheme.

· Use the navigation arrows to view the results of the previous measurement. If
you select the measured wheel, the saved back-to-back distance will be
displayed. 
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· When you select the measured wheel, the application will warn you that the
measurement with such parameters has already been saved in the database
and will offer to save the new measurement instead of the existing one.

All saved measurements will be saved to the database (see par. Viewing
measurement results).
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17.     IKP calibration
The profilometer can be supplied complete with the calibration block (RF505.1)

designed for periodic testing and calibration of the profilometer.
Instead of the calibration block, you can use a wheel with a known profile saved

in the database (see par. Reference profile).

17.1.     Preparing for calibration

· Turn on the laser module.
· Install laser module on the calibration block.
· Wait until the Bluetooth connection is established between the module and

PDA -  the Calibration button will become active. 
· Tap the Calibration button. The application will request the calibration

parameters of the laser module (if the parameters were not received earlier)
and, if the parameters were successfully read, the Calibration window will
appear.

17.2.     Calibration procedure

The Calibration window contains two tabs: Measurement and Parameters. 
The Measurement tab displays the selected reference profile and its

parameters, as well as the measured profile and calculated parameters (after
measurement).

The Parameters tab displays the IKP calibration parameters written to the
FLASH memory of the device. 
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To perform automatic calibration, follow these steps:
· Tap the MEASUREMENT button.

· Tap the AUTOCALIBRATION button. The calibration parameters will be
automatically calculated and the measured profile will be recalculated. 
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· Tap the WRITE PARAMETERS button to save parameters.
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18.     Browsing the database

To view the saved data, go to the main menu (tap , or swipe right from the left
edge of the screen) and select Profiles. 

 

The application will display a list of the measured locomotives/cars, as well as
their total number and the number of measured wheels. 

18.1.     Exporting data

To export several or all locomotives/cars, you need to tap and hold the required
locomotive/car. Multiple selection mode will start. Before exporting, you can filter the
required data (see par. Filtering data).

Then select the locomotives/cars that you want to export to a PC and tap .
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If several options are selected in the export settings, a menu will appear on the
screen with options for exporting data.

 

· To export to a PC, select Export to DB ikp5_BD

Attention!
To successfully export data to a PC, the Ikp5_DB program must be launched, and the correct IP
address must be set in the PC server settings
(see PC Server Settings)

If unsuccessful, a pop-up message will appear on the screen:

· To save data to your Android device, select Save to smartphone.
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The data will be saved in the internal memory in the \\Download folder.

· To send data by email, select Send email.
The data will be sent to the email address entered in the settings.

Attention!
To successfully send data, the smartphone must be connected to the Internet.

18.2.     Filtering data

To add a filter, tap the Filter button ( ), and then select the fields by which the
data will be filtered.
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An example of filtering by date:

Tap on the date selection icon ( ) and select the date.

Tap  to apply a filter. The app will display only those measurements that
match the filter.  
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You can also filter the measured data for a specific period of time. To do this,
you need to enable the Period selection option and select the required period in the
calendar.

To add a filter by series or locomotive/car number, select the required value from
the drop-down list. 
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To delete the current filter, tap the filter button and disable the filter.

18.3.     Deleting data

To delete a locomotive/car, swipe left from the right edge and tap Delete.

To delete some or all locomotives/cars, you need to tap and hold the item.
Multiple selection mode will start.
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Buttons:

 - delete the selected items;

 - select all;

 - export the selected data to a PC (Ikp5_db program).
If the Send email option is selected in the settings, the following button is also

available:

 - send the selected data by email.

18.4.     Viewing measurement results

To view the measurement results, tap on the required locomotive/car. A list of
measurements for the selected locomotive/car will appear. 
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In this mode, the user can delete or export data.

18.4.1.     Saving the wheel profile as the reference

The user can also save the profile of the selected wheel as a reference. To do
this, swipe left over the item and tap Save. 

Then enter the name of the reference or agree with the proposed one (by

default, the name is the locomotive/car series) and tap  to save the reference.

The saved references are stored in the database: Settings > References (see
par. Reference profile).
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18.4.2.     Viewing wheel parameters

To view the parameters and profile of the selected wheel, tap on the required
item. 

The window displays the identification data of the measured wheel, the
measured profile and the calculated parameters. It is possible to disable the display of
the reference profile - for this you need to clear the Reference profile check box.
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18.4.3.     Viewing the wheel profile

The profile can be zoomed in. To do this, touch the profile with two fingers at
once and, without lifting the fingers from the screen, spread them apart.

19.     Data exchange between PDA and a PC
To exchange data between a mobile device and a PC, select the device: File >

Device > Mobile Device. 

19.1.     Synchronization of PDA and a PC

A Wi-Fi connection is used to transfer data between the mobile device
To connect you must do the following:
1. Select the synchronization type: Mobile device > Synchronization > WiFi.
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2. Go to server settings: Settings > DB, Server settings.

To transfer data, the PC and mobile device must be connected to the same Wi-
Fi network. This can be a dedicated network created on an Android device (virtual
hotspot) or any home/work network. 

Ikp5_DB server port settings: 
Port - port number for connecting a mobile device (8090 by default)
The port number must be the same as specified in the mobile application (see

par. PC server settings).

Mobile device server settings:
IP address and Port - address and port number of a mobile device in the

network.
These values must be the same as specified in the mobile application (see par.

Ikp server settings).
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19.2.     Data transfer

When you select to sync over Wi-Fi, the following options become available:
· Transferring the database file.
· Transferring the reference file.
· Transferring the scheme file. 

19.2.1.     Transferring the database file to a PC

When you sync data over Wi-Fi, the measurement results are exported from the
Ikp mobile app (see par. Exporting data to PC).

19.2.2.     Transferring the reference file

To transfer the reference file from a PC to a mobile device, follow these steps:
- Select Mobile device > Reference file > Export.

- Select the required file (*.ref).
If the data transfer is successful, the following message will appear:
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19.2.3.     Transferring the scheme file

To transfer the scheme file from a PC to a mobile device, follow these steps:
- Select Mobile device > Scheme file > Export.

- Select the required file (*.sch).
If the data transfer is successful, the following message will appear:

20.     Installation of software on PC and startup

20.1.     Installation of database support software

The ikp5_DB software is intended for maintaining wheel sets wear database on
a personal computer (the updated version of the program can be downloaded from
www.riftek.com/media/documents/ikp/Ikp5_PC_Software.zip). 

To install the software, insert a compact disk to the PC CD drive, select and start
the Install_Ikp5.exe file in the Software folder. Follow guidelines of the installation
wizard. By default, the software will be installed in the following directory C:\Program
Files (x86)\Riftek, LLC\Ikp5_db\.

20.2.     Synchronization of PDA and PC

There are two ways of synchronization via USB cable to transfer data between
PDA and PC:  

· MS ActiveSync

http://www.riftek.com/media/documents/ikp/Ikp5_PC_Software.zip
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· Mass Storage 
When you select MS ActiveSync, synchronization with PC is performed via the

ActiveSync software (Windows XP), or via Windows Mobile Device Center (Windows
7), which must be installed on PC.

It is necessary to select MS ActiveSync as the synchronization type.

When you select Mass Storage, the device will be detected in Windows as an
external storage device.

It is necessary to select Mass Storage as the synchronization type.
To check if the MS ActiveSync synchronization is correct, switch on the PDA

and connect it to the USB port of the PC by the supplied cable. If the connection is
successful, a message about it will appear on the screen:

20.3.     Program startup

To start the program, click Start > All programs > Riftek, LLC > IKP5_DB >
Ikp5_DB.exe. View of the main program window is shown below.



IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

95

21.     User settings of the program

21.1.     Parameters setting

To go to the window of parameters setting, click Settings > Parameters in the

main window, or click .

The window of parameters contains 4 tabs:
· Wheelset's parameters
· Calculated parameters
· L parameters
· Measurement method

21.1.1.     "Wheelset's parameters" tab

This tab is intended to select parameters, which will be displayed on the screen
when viewing the database.

If the parameter is ticked, its value will be shown in the table of results and in the
table of profiles. 
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21.1.2.     "Calculated parameters" tab

This tab is intended to select the wheelset geometrical parameters, which will be
calculated and displayed on the screen when viewing the database.

Description and functions of parameters are the same as in the PDA software
(see par. 10.).

21.1.3.     "L-parameters" tab

This tab is intended to set the values of reference points for calculated
geometrical parameters of the wheelset.

Description and functions of the reference points are the same as in the PDA
software (see par. 10.).

21.1.4.     "Measurement method" tab

This tab is intended to select the calculation method.

Description and functions of the measurement methods are the same as in the
PDA software (see par. 10.).
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21.1.4.1.     Selection of measurement units

All parameters and measurement results can be in the Metric system
(millimeters), or in the English system (inches). 

To set the units of measurement, you need to select mm or inches in the Units
of measurement field. After saving the changes, all information will be displayed in the
selected units of measurement.

21.2.     Database settings

21.2.1.     Setting the path to database

It is possible for the user to change the drive and the directory of the profiles
database storage. In the main window, select File > Path to DB...

Next:
· click Ok
· specify a new path to the database 
· confirm the creation of a new database 

All database files will be copied to the specified path.
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21.2.2.     Creation of empty database

To create an empty database, select File > New DB.

All data except the reference files will be deleted from the database. At the
same time, the DB(dd.mm.yy) directory will be created in the installation directory
whereto all the deleted data will be copied (dd.mm.yy – current date). If necessary,
these data can be restored (see par. 21.2.3).

21.2.3.     Import of database

To import data to the database from the other database, you need to:
· Select File > Import Data.
· Select the directory with DB files in the left window. All files will appear in the

right window:

· Click OK to import data.

21.2.4.     Selection of software language

To change the software language, select Settings > Language and select the
required language support file.
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21.2.4.1.     Preparation and installation of the language support file

The user can change the language, form his own language support files as well
as change/edit the terminology used. Language support files are located in the directory
used in the process of installation. By default, the following directory is used: C:
\Program Files (x86)\Riftek, LLC\Ikp5_db\Language\. 

The directory contains two files, RUS.lng and ENG.lng, to support Russian and
English languages respectively. 

To create the support file for any other language, it is necessary to: 
· copy one of the existing files, for example - ENG.lng, under the other name,

for example - DEU.lng; 
· edit the renamed file by using any text processor, namely, change all terms

and phrases to analogous ones from the required language;
· save the edited *.lng file in the Language directory.
To change and edit terminology, it is necessary to:
· edit the corresponding language file by using any text processor;
· save the edited *.lng file in the Language directory.

21.3.     Registration data

21.3.1.     Selection of the organization

To add/chose the user organization, select Registration > Organization.
Subsequently, this information will be used in automatic generation of reports.

Buttons:

Add a new organization

Delete the selected organization

Edit the selected organization

Exit the mode

To select a current organization:
· Click Edit
· Tick the depot
· Click Save
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21.3.2.     Registration of operators

Steps to follow: Registration > Operator. Operators data are used for
identifying operators by Number.

Functions of buttons are similar to those in par. 21.3.1.

21.3.3.     Registration of series

Steps to follow: menu Registration > Series. Registered series of cars or
locomotives are displayed in the emerged window.  

When registering a new series, a new entry for this series will be added in the
table of tolerances automatically (see par. 21.3.5).

Functions of buttons are similar to those in par. 21.3.1.
When adding a new series, it is necessary to enter the name of the series and to

select the reference profile for it. Flange parameters of the selected profile will be
calculated and added to the table of tolerances automatically after saving the series (see
par. 21.3.6).
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21.3.4.     Registration of car/locomotive numbers

Steps to follow: menu Registration > Number. Registered numbers of
cars/locomotives are displayed in the emerged window.  

Functions of buttons are similar to those in par. 21.3.1.

21.3.5.     Registration of tolerances

Steps to follow: menu Registration >Tolerance. Registered series of
cars/locomotives with boundary values of calculated geometric parameters of the
wheelset are displayed in the emerged window. 

Only parameters, which were selected in the list of parameters, are available for
editing (see par. 21.1.2.). 

Maximum/minimum critical values of parameters are indicated with a red color.
An orange color indicates maximum/minimum values of parameters, which are close to
critical.

The Norm value is calculated and added to the table automatically when
adding/editing the series of the selected reference (see par. 21.3.3).

21.3.6.     Registration of reference profiles

The program comes with several preset profiles. In addition, the supplied disc
with software contains the base of reference profiles. Profiles are in the Reference
Profiles directory and divided into separate directories for each country.

In addition, the user can form a description of the required profile himself or
request it from RIFTEK (free service). 

To browse available profiles, select Registration > Reference:
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The window of profiles displays the table with the list of reference profiles, saved
to database, and a graphical view of the selected profile.  

Buttons:

Delete the reference profile 

Import the reference profile from *.ref file

Export the reference profile to *.ref file

Exit the mode

21.3.6.1.     Request and registration of the profile file

To get .ref file of reference profile send the drawing of profile to RIFTEK
(info@riftek.com). Register the received .ref file as follows:

· click Import
· in the window appeared indicate the way to the .ref-file
· click Open
The profile will be added to the base of reference profiles.
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22.     Data exchange between PDA and PC
To exchange data between PC and PDA, you need to select the device: File >

Device > RF303M-PDA. 

Data exchange between PC and PDA is performed by means of direct cable
connection of PDA to PC USB-port (special RF505.42 cable is supplied).  

There are two ways of synchronization via USB cable:
· ActiveSync
· Mass Storage 
For more details see par. 20.2. 

22.1.     ActiveSync synchronization

When you select this type of synchronization, additional features of data
exchange with PDA will be available:

· Transfer of database files to PC.
· Transfer of language files.
· Transfer of reference profile files.
· Transfer of processing scheme files. 
· PDA software update.

22.1.1.     Transfer of database file to PC

To transfer the database file from PDA to PC, it is necessary to:
· Select PDA > Import Data.

· Mark the required files in the emerged window and click OK.
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Double-click on the selected file in order to see information about saved data.

22.1.2.     Transfer of language file from PC to PDA

To transfer the language file from PC to PDA, it is necessary to:
· Select PDA > Language file > Export.

· Select the required file.
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If transfer is successful, the screen will show:

22.1.3.     Transfer of language file from PDA to PC

To transfer the language file from PDA to PC, it is necessary to:
· Select PDA > Language file > Import.

· Select the required file.

If transfer is successful, the selected files will be saved to the specified path.

22.1.4.     Transfer of reference profile files from PC to PDA

To transfer the reference profile file from PC to PDA, it is necessary to:
· Select PDA > Reference file > Export.
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· Select the required .ref file.
If transfer is successful, the screen will show:

22.1.5.     Transfer of processing scheme file from PC to PDA

To transfer the processing scheme file from PC to PDA, it is necessary to:
· Select PDA > Scheme file > Export.

· Select the required .sch file.
If transfer is successful, the screen will show:

22.1.6.     Updating of PDA software

The latest software version can be downloaded from the website:
www.riftek.com/media/documents/ikp/Ikp5_PDA_Software.zip. 
To transfer the update file to PDA, it is necessary to:
· Select PDA > PDA update.

· Select file for transfer.

http://www.riftek.com/media/documents/ikp/Ikp5_PDA_Software.zip
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If transfer is successful, the window will appear:

22.2.     Mass Storage synchronization

When you select this type of synchronization, PDA is detected as an external
storage device. Therefore, only the Import Data item is active. Transfer of
language/scheme/reference files  from PDA to PC and back can be performed by simple
copying.

To transfer database files from PDA to PC, it is necessary to:
· Select PDA > Import Data.
· Specify the path to the database on PDA (by default, SDMMC\Autorun\DB).

· Mark the required files in the emerged window and click OK.

Double-click on the selected file in order to see information about saved data.
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23.     Working with profilograms and wear calculations

23.1.     Browsing the graph and profile coordinates

To browse the saved profiles of the rolling surface, select Database > Profiles,

or click the Profiles button - .

At the left side of the window you can see the Table of profiles tab, which
contains a list of saved profiles. The table displays only those identification parameters
of the wheel, which were selected in the parameters window (see par. 21.1.).

When selecting a profile, it is possible to browse a graphical image and
geometric parameters of the measured wheel. To browse the coordinates of the
selected profile, you need to click the Profile Values button. After that, an additional tab
with the measured coordinates will appear.

Buttons:

Show/hide the Wear graph

Show/hide the Profile Values tab

Show/hide the Profile alignment tab 

Save the profile image to file (.bmp file)

Print the profile image 

Change the background color of the graph 

Zoom in/out the profile graph 

Calculate geometric parameters of the wheel 
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23.2.     "Parameters" tab

Calculated geometric parameters of the profile as well as L-parameters values
are displayed on the Parameters tab, which is at the bottom of the window.

If needed it is possible to change settings of the calculated parameters or
support points (see par. 21.1).

23.2.1.     Selecting a profile to compare

There are two ways to compare:
· with the reference profile,
· with the measured profile.
To compare the measured profile with the reference one, it is necessary to tick

the Reference box.
When comparing with the reference profile, select the required reference profile

in the drop-down list.

To compare two measured profiles (for example, profiles of left and right
wheels), it is necessary to tick the Measured box. The Table of profiles tab will show
an additional table for selecting a profile to compare.

23.2.2.     Selecting L-parameters values

When calculating the geometric parameters of wheelsets, the specified support
points are used (see par. 21.1.3). There are two variants of L-parameters:

· General parameters 
· Profile parameters 
When selecting General parameters, values of L-parameters will be taken from

the default parameters file (see par. 21.1.3).
When selecting Profile parameters, values of L-parameters will be taken from

the profile file, i.e. the values, which were set in PDA when measuring the wheelset.
Values of L-parameters are displayed on the screen in the table of parameters.

If necessary, it is possible to edit any value and to recalculate values of
geometric parameters of the flange. To do it, click Calculate. Parameters of the
measured profile and selected reference will be recalculated.
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23.2.3.     Geometric parameters of the profile

The table of calculated geometric parameters displays only those parameters,
which were selected in the parameters window (see par. 21.1.2).

Parameters, which are beyond the set tolerances, are highlighted in red/orange
(see par. 21.3.5).

23.3.     Wear calculation

23.3.1.     Fast wear calculation

To obtain fast calculation of the profile wear at a certain point relative to the
reference, put cursor bar to any of the profiles, and when a cross-like (+) mouse cursor
appears press the left mouse key. The resulting screen will show the value of the
coordinate difference between profiles taken along X- and Y-axes, as shown by arrows:

To remove size indication from the screen, it is necessary to put cursor to any of
the profiles and press the right mouse key.

23.3.2.     Wear calculation at all points

To calculate the wear at all points of the measured profile, it is necessary to click
the Wear button. Calculated wear will be displayed on the screen in a graphic form:
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The graph displays positive and negative values of the wear area. Value of the
wear area is calculated in square millimeters with respect to the selected reference
profile:

To view the table of wear values, it is necessary to select Profile Values >
Wear. The table will show deviations of the selected profile from the reference profile in
two directions (X and Y).

23.3.3.     Export to Excel, DXF, REF

To export the table to the Exсel or DXF format or to create the reference file
(REF), it is necessary to right-click on the table. The pop-up menu will appear:

Select the needed menu item.

23.4.     Alignment of profiles

For alignment (vertical translation) of profiles, you need to click the Alignment
button. The program will display an additional tab, where you can select a profile:
Reference or Measured. The selected profile will be marked with red.

   
After selecting the profile, the screen will display the maximum and minimum

deviations of the selected profile from the reference profile [Min dY..Max dY].
Next, specify the translation step and move the profile by using the Up/Down,

Left/Right buttons.
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To save the changed profile, go to the tab of identification parameters of the
profile and click Save. 

To create a new profile, it is necessary to change the identification parameters of
the profile.

23.5.     Superposition of profiles

To superimpose several changed profiles, you need to tick the required profiles
in the left table. Selected profiles will be displayed in different colors. 
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23.6.     Rescaling

To change the image scale, mark a part of the image with the left mouse key,
move the image by holding it with the right mouse key pressed, or with buttons Increase

-  , Decrease -   and Show all - .

24.     Implementation of minimum wheel truing
function

Select Tools > Analysis of profiles. The analysis of wheel profiles allows to
choose such a type of the profile from the reference profiles, for which the total truing
depth of two wheels would be minimal.

In the first table of profiles, select the first required profile of the wheelset (left
wheel); in the second table of profiles, select the second required profile of the wheelset
(right wheel).

The program allows to perform the automatic analysis by all the reference
profiles, which stored in the database, or by the selected profile only.

· Automatic analysis
Tick the box and click the Analysis button. Profiles in the table of references

must not be marked.

· Analysis by the selected profile
Select the reference profile for analysis and click the Analysis button.
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To know the wheel cutting depth in a certain point, put the cursor to any profile,
and when a cross-like (+) mouse cursor appears press the left mouse key. The resulting
screen will show the value of difference between profiles along X- and Y-axes, as shown
by arrows. To remove size indication from the screen, put cursor to any of the profiles
and press the right mouse key.

25.     Scanning and editing of data

25.1.     Scanning and filtering of data

Select Database > Table in the menu or click the Table button - . The form
with results will be as follows:

· Hide/show the field 
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The table displays the identification and geometric parameters of the wheelset,
which are selected for displaying in the parameters settings (see par. 21.1.1 and
 21.1.2).
· Sorting of data
To sort data for any of the fields, click the left mouse key on the header of the

field column:

To cancel data sorting, press the Ctrl key and click the left mouse key on the
header of the field column.

· Filtering of data 
In order to filter data in any of the fields, click the left mouse key on the header

of the field grouping, and select the required value in the emerged drop-down list:

To cancel filtering, all steps should be taken in the reverse order.
· Data grouping
To group data for any of the fields, click the left mouse key on the header of the

field column, and, with the mouse key pressed, drag it onto the table header:

· Changing of the field position order 
To change the field position, click the left mouse key on the header of the field

column and, with the mouse key pressed, drag it to the required position:
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Buttons:

Add the wheel pair 

Delete the selected wheel pair 

Delete all wheel pairs 

Edit the selected wheel pair 

Export the coordinates of wheel pairs to the Excel format

Report preparation 

25.2.     Editing data

You can edit, add and remove data in/from the database.
· Editing data

To edit the current entry, click the Edit button and input/change required values
of parameters. After the editing is complete, click the Save button.

· Adding data

To add a new data entry, click the Add button and type required parameter
values. After the editing is complete, click the Save button.
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· Deleting data
To delete the current entry, click the Delete button and confirm the deletion.

· Deleting all selected data
If it is necessary to delete not only one entry but several entries combined by

some condition, filter the data according to the corresponding attribute (see par. 25.1),
click the Delete all button and confirm the deletion.

25.3.     Report preparation

When staying in the mode of scanning and editing data, the user can prepare
reports in Excel, RTF, PDF formats, or print out reports. When preparing the report, the
sorting used at the moment is taken into account.  

To generate a report, click the Report button. The program will offer to select the
following options:
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25.3.1.     Excel-format report

To prepare a report in Excel format, select Report in Excel and click ОК. 

25.3.2.     Report for printout

To prepare the report for printout, select Report for printout and click ОК. Data
will be presented in the form of report ready for printout. 

The top toolbar contains the following buttons for operating with reports: 

· To printout the report, click .

· To save in PDF format, click .

· To save in Excel, RTF or PDF, click  and select the format you need:
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26.     Taking measurements under PC control (without
PDA)

The laser scanning module (RF505) can work under direct control of PC without
PDA. To work under direct control of PC, it is necessary to select File > Device >
RF505-Profilometer in the main menu.

In the main menu of the program, the PDA tab will be replaced with the
Profilometer tab.

The menu contains two available items:
· Calibration 
· Measurement 
Before you start working with the profilometer, it is necessary to set the COM

port for Bluetooth connection between the laser scanning module and PDA. The
procedure is described in the User's manual that comes with the Bluetooth adapter.
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26.1.     Calibration

To calibrate the device, select Profilometer > Calibration, or click . 

26.1.1.     Bluetooth connection

Select the COM port and click the Connect button.

 

For more information, refer to par. 29.

If the connection is successful, the device will be identified, and calibration
parameters will be obtained. The status will be changed to Connected.

The table of calibration parameters: 
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Buttons:

Measurement.

Reading calibration parameters.

Writing calibration parameters.

Automatic setting of calibration parameters.

The Auto calibration button will be active, if at least one measurement of the profile is
performed and the reference profile is selected.

26.1.2.     Calibration of the profilometer

· Place the profilometer on the calibration block. 
· Select the reference profile from the list (Compare > Reference). 
· Perform the measurement (the Measurement button)
· Perform the calibration (the Autocalibr button).
· Save calibration parameters (the Write param. button).

Calibration parameters can be set manually. To do it, click left mouse key on the
field of the required parameter value, and enter the new one.

Attention! Writing incorrect values of some parameters can lead to the incorrect work of the
device.

Buttons functions, work with profiles and calculation of required parameters are
described in par. 21.
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26.2.     Measurement by using PC

To measure, select Profilometer > Measurement, or click the button . 

When the Bluetooth-connection is established (see par. 26.1.1), the
Measurement button is active.

26.2.1.     Saving of data

· Place the profilometer on the wheel.
· Perform the measurement (the Measurement button).
· Enter the identification parameters of the wheelset.

· To save results, click Save.
· The measured profile will be saved to the database.
Buttons functions, work with profiles and calculation of required parameters are

described in par. 21.
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27.     Annex 1. Charging procedure
· Switch off the PDA (laser module).
· Connect the charging device to PDA (laser module).
· Connect the charging device to 220V AC.
· Full-charge indication of laser module - green LED is lit.
· Disconnect the charging device from 220V AC.
· Disconnect the charging device from PDA (laser module).

Attention! Please follow the sequence of these points.

28.     Annex 2. Program for creating the measurement
schemes

To create the measurement schemes, use the special program
SchemeBuilder.exe. When the program is started, the main window appears on the
screen:

To form the scheme: 

· Enter the number of cars 

· Enter the number of axles in every car 
· If the measurement of the car is performed in the reverse order, tick the box

· Select the type of the scheme 

· Click the button to accept 
· Next, enter parameters of all wheelsets sequentially for each car 

· The fields Axle and Car are used to navigate through the scheme 
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· Click the Save scheme button 
· Enter the name of the scheme in the dialog box window

The program allows to edit the existing scheme. To edit the scheme, click the
Load scheme button and select the *.SCH file. After loading, you can edit and save the
wheelset parameters.

To transfer the scheme file to PDA, use the procedure described in par. 22.1.5.
Clarification. The measurement scheme is a text file with extension .sch. User

can create and edit such file by using any text processor. 
Example:

Scheme_EXAMPLE 
{ 
1d-|SM3|7102|1l|11|SU11|111|1r|11|SU11|111|2l|12|SU12|112|2r|12|SU12|112|3l|13|SU13|113|3r|13|SU13|113|4l|14|SU14|114|4r|14|SU14|114|; 
2d-|SM3|7202|1l|21|SU21|211|1r|21|SU21|211|2l|22|SU22|212|2r|22|SU22|212|3l|23|SU23|213|3r|23|SU23|213|4l|24|SU24|214|4r|24|SU24|214|; 
3d-|SM3|7302|1l|31|SU31|311|1r|31|SU31|311|2l|32|SU32|312|2r|32|SU32|312|3l|33|SU33|313|3r|33|SU33|313|4l|34|SU34|314|4r|34|SU34|314|; 
4i-|SM3|7402|4r|44|SU044|414|4l|44|SU44|414|3r|43|SU43|413|3l|43|SU43|413|2r|42|SU42|412|2l|42|SU42|412|1r|41|SU41|411|1l|41|SU41|411|; 
5i-|SM3|7502|4r|54|SU54|514|4l|54|SU54|514|3r|53|SU53|513|3l|53|SU53|513|2r|52|SU52|512|2l|52|SU52|512|1r|51|SU51|511|1l|51|SU51|511|; 
6i-|SM3|7602|4r|64|SU064|614|4l|64|SU64|614|3r|63|SU63|613|3l|63|SU63|613|2r|62|SU62|612|2l|62|SU62|612|1r|61|SU61|611|1l|61|SU61|611|; 
} 

Where:
1d – coaches arranged in direct order (1 – sequence number) 
1i – coached arranged in the reverse order (1 – sequence order)
SM3 – coach series 
7102 -number
1l – sequence number of wheel pair and the side (l- left/r-right) 
11 – axle number 
SU11 – name of wheel set 
111 – running distance of wheel set
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29.     Annex 3. Testing and calibration
We can supply the profilometer complete with an RF505.11 calibration-wheel

simulation unit (Fig. 1A) and RF505Calibr calibration program that are designed for
periodic testing and self-calibration of the profilometer.  

Instead of the calibration unit use can be made of the wheel with known profile
entered to the database (see par. 21.3.6).

Before start the testing and calibration process, it is necessary to set the COM-
port for Bluetooth-connection between the laser scanning module and PDA. The
procedure is described in the user manual that comes with the Bluetooth-adapter.

When you add the device, Windows will ask for the pairing code. The pairing
code for each device consists of 4 symbols and is formed according to a serial number.
For example, if a serial number is 04217, then a code will be 0427; if a serial number is
01318, then a code will be 0138, etc.

Figure 1A

29.1.     Preparation for testing/calibration

· Install the RF505 program on the PC.
· Install Bluetooth-connection between the scanning module and PC. 
· Place the profilometer on the calibration unit.
· Run RF505 program.



126

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

· To install Bluetooth-connection, select the required port.

The device will be identified, and calibration parameters will be read.
· To perform the measurement, pass to the Profile tab and click Measurement.

After measuring, the display will show the measured profile and the calculated
geometric parameters of the profile: Height (Sh), Thickness (Sd), Slope (qR).
Parameters are measured at support points L1, L2, L3.

· To compare with the reference, tick the Compare box and select the required
reference profile in the Reference drop-down list. 
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29.2.     Testing

To carry out automatic testing, do the following steps:
· Tick the N meas. box (number of measurements).
· Specify the number of measurements (5-10).
· Click the Measuring button.

The scanning module will make the specified number of measurements whose
results will be entered to the table (the Data tab). The first three columns will present
measured values of height (Sh), thickness (Sd), and flange slope (qR), while the other
three columns will present deviations of the measured values from the reference values
(d_Sh, d_Sd, d_qR).

The Diagram tab is intended for displaying the diagram of values/deviations of
the measured profile from the selected reference. Deviation of the flange height and
thickness from the reference values must not be more than 0.1 mm. If deviations exceed
the permissible value, it is necessary to perform calibration of the scanning module.



128

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

29.3.     Calibration

To carry out automatic calibration, do the following steps:
· Select the reference profile from the list. 

· Perform the measurement (the Measuring button).
· Perform the calibration (the Auto calibration button).
· When scanning is complete, perform the testing procedure in accordance with

29.2. In case of positive result, save parameters:
oRight-click on the table and select Write.
oRight-click on the table and select Write to FLASH.
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29.4.     Restoring the factory settings

If parameters have incorrect values (negative or zero), it is necessary to restore
the factory settings by pressing the Load Default button. After that, recalibrate the
profilometer.
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30.     Annex 4. Software application for working with
the "A.U.R.A. Wheel" system

When working with the A.U.R.A. Wheel system from NEM Solutions, the laser
scanning module is controlled by the special software application installed on a tablet
computer.

30.1.     Installation

To install the software, select and run the Ikp5_Tablet.exe file. Follow the
guidelines in dialog boxes of the Installation Wizard. By default, the software will be
installed in the following directory – C:\Program Files (x86)\Riftek, LLC\Ikp5_Tablet\.

To start the program, press Start > All programs > Riftek, LLC > Ikp5_Tablet >
Ikp5_Tablet.exe. The main window is shown below:

30.2.     Settings

Before starting to work with the profilometer, it is necessary to configure
parameters.

Press the Settings button. The program will require a password. When initially
installed, the program accepts the following password: 1111. How to change the
password, see Par. 30.2.3.
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Enter the password and press Ok. The window of program settings will appear.

30.2.1.     Language

The user can change the language, form his own language support files as well
as change/edit the terminology used. To select the language, press Language, select
the language support file, and press Select.

How to create the language support file, see Par. 21.2.4.1.

30.2.2.     Gauge type selection

The program allows to work with the following gauges: IKP, IDK, IMR. When
selecting one of them, you will see a list of available devices (i.e. devices that have been
connected earlier).

Select the gauge and press the Select button. Parameters of the selected gauge
will be used to connect to it. If the device is not in the list, you can add it – press the Add
button and start to search for Bluetooth devices.
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Press Start and wait for the search to complete.

The detected devices with their serial numbers will appear:
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Select the device and press Pair gauge to include it in the list. Windows will
report an attempt to add a new device, and request a pairing code. 

If the pairing code is correct and the device is successfully added, the system
will display a message. The device installation may take some time. The pairing code for
each device consists of 4 symbols and is formed according to a serial number. For
example, if a serial number is 04217, then a code will be 0427; if a serial number is
01317, then a code will be 0137, etc.

Select the device by pressing the Select button.
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If you do not use the device anymore, you can delete it by pressing the Delete
button. Similarly, you can add other gauges (IDK and IMR).

30.2.3.     Password

To change the password, press Password.

Enter a new password, confirm it, and press Save.
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30.2.4.     Calculation methods

Press Calculation method. On the screen:

To save the changes, press Save.

30.2.5.     Selection of displayed parameters

Press Displayed parameters. On the screen:

In order to select/deselect a parameter, set ON/OFF in the Show/Hide column.
To save the changes, press Save.
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30.2.6.     L-parameters

Press L parameters. The table displays only those L-parameters that are
necessary to calculate the selected geometrical parameters of the wheel. 

To save the changes, press Save.

30.2.6.1.     Preset values

L-
parameter

Default value Assignment

L1 2 mm Used for calculation of the flange slope (qR) 

L2 70 mm Defines position of the wheel rolling circle, and used for calculation:
- flange height (sH)
- flange thickness (sD)
- flange slope (qR)
- inclination angle (A)
- wheel diameter (D)
- rim thickness (T)
- wear (Wt, Wf, Wr)

L3 13 mm Used for calculation:
- flange thickness (sD)
- flange slope (qR)
- wear (Wf)

L4 13 mm An additional point for calculation of the flange slope (qR)

L5 10 mm Used for calculation of an angular wear (Wr)

L6 70 mm Used for calculation of slope of the rolling surface section (S1)

L7 105 mm Used for calculation of slope of the rolling surface section (S2)

L8 10 mm Used for measurement of the profile inclination angle at the required
point (A)

L9 140 mm Used for inverting the measurement direction (L9 – profile width)

L10 599,35 mm Used for calculation of the profile diameter (D)

L11 767 mm Used for calculation of the reference profile rim thickness (T)

L15 13 mm Used for calculation of the flange thickness of tram wheels (sD15)
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P7_1 
P7_2
P8_1
P8_2

50 mm
105 mm
110 mm
130 mm

Used for calculation of the hollow (Hl)

D1 
D2

70 mm
107,5 mm

Used for calculation of the hollow (Hl)

30.2.7.     Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the
reference profile. To select the reference profile, press Reference.

To delete the reference file, activate the line and press Delete.
To add the reference file, press Import and select the *.ref file.

30.2.7.1.     Writing the reference profile to the database

Reference profiles are stored in the database as profile description files with the
.ref extension. The software is supplied with several preset profiles. 

If there is no required reference profile in the database, the user can request the
missing profile from RIFTEK (free service).

30.2.8.     Measurement scheme

The measurement scheme is meant as a sequence of making
measurements/processing of wheels in the rolling stock with specified parameters of
each wheelset (wheelset numbers, car numbers, series, etc.). The program
automatically offers the operator to perform measurement of the wheel in accordance
with selected scheme of wheel processing. The program contains several preset
schemes. Besides, the user can form his own measurement scheme.
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30.2.8.1.     Selection or removal of the measurement scheme

To select the measurement scheme file, press Scheme.

Arrows in the figure show the direction of processing of wheelsets as well as the
names assigned to wheels.

To delete the scheme file, activate the line and press Delete. If you delete the
current scheme, the error message will appear.

To add the scheme file, press Import and select the *.sch file.

30.2.8.2.     Formation of a new measurement scheme

To form a new measurement scheme, press Add. The following window will
appear:

Next:
· Enter the scheme name.
· Select the number of cars.
· Select the number of axles.
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· Select the wheel processing scheme out of the options suggested.
· Press Ok.
This method of the measurement scheme formation allows to create only simple

schemes without specifying the wheelset numbers, car numbers, series, etc.

30.2.9.     Tolerances

The program automatically controls measured geometric parameters for going
out beyond the tolerances set. It is possible for the user to create groups of tolerances.
Control of parameters will be performed for a selected group. 

To select a current group of tolerances, press Tolerance. The table will show
tolerances only for the selected geometric parameters of the wheel.

A red color indicates the maximum/minimum critical values of parameters. An
orange color indicates the maximum/minimum values, which are close to critical values.

To delete the tolerance, activate the line and press Delete.
To edit the tolerance, activate the line and press Edit.
To add a new tolerance, activate the line and press Add. On the screen:
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Enter the tolerance name into the Name of tolerance field and the values into
the Min/War.Min/War.Max/Max fields. To save the changes, press Save.

30.2.10.     Vehicles

To view a list of rolling stocks, press Vehicle. The listed rolling stocks can be
selected for measurement.

Parameters of the rolling stocks:

Vehicle name Name of the rolling stock

Vehicle Id Identification number of the rolling stock

Vehicle description Description of the rolling stock

Schedule Schedule for the rolling stock

Send to AURA
Select "Yes" if you want to send data to the AURA database, or select "No" if you
don't

Scheme Measurement scheme name

# axles Number of axles

# wheels Number of wheels

Reference Reference name from a list of references (Reference tab)

Tolerance Tolerance name from a list of tolerances (Tolerance tab)

To delete the rolling stock, activate the line and press Delete.
To edit the rolling stock, activate the line and press Edit.
To add a new rolling stock, activate the line and press Add.

30.3.     Measurements

There are three types of measurements:
1. Single Measurement – measurement without specifying the rolling stock type,

measurement scheme, tolerances. Measurement results can be saved to the
WMC format.

2. Simple Measurement – measurement of the selected rolling stock with
specifying the scheme and tolerances. Measurement results are saved to the
WMC format.

3. Automated Measurement – measurement of the selected rolling stock with
specifying the scheme and tolerances. Measurement results are transferred
to the AURA database.



IKP-5 Series, Model 2024 Year [Revision 2.0.0] 14.01.2024

Laser Wheel Profilometer. IKP-5 Series, Model 2024 Year

141

30.3.1.     Single measurement

To enter the mode, press the Single Measurement button.

First, you need to establish the Bluetooth connection to the gauge: IKP, IDK or
IMR.

The list contains devices selected in settings (see Par. 30.2.2. "Gauge type
selection"). After selecting, press the Connect button.

The Measurement button and the charging indicators will be active.
· Press the Measurement button.
· After pressing the Measurement button, the laser module starts scanning of

the wheel surface. During the scanning process (1-2 seconds), a red LED is lit.
· When the scanning process is complete, the program displays the

measurement results.
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Measurement results and profile coordinates can be saved to the file of the
WMC format. The files are saved to the following directory:

С:\Riftek,LLC\Ikp5_Tablet\Measurements\Losse metingen\

The IDK is designed to measure the wheel diameter. The IMR is designed to
measure the back-to-back distance. In order to change the gauge type, press the
Disconnect button, select the gauge you need, and press Connect.

The measurement procedure is similar to IKP.

30.3.2.     Simple measurement

To enter the mode, press the Simple Measurement button. This mode allows to
perform measurements in accordance with the rolling stock parameters (scheme,
tolerances, reference).

First, you need to select the rolling stock in the Select Vehicle window. The list
contains only those rolling stocks, the measurement results of which will not be sent to
the AURA database (the Send to AURA column is empty).
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Select the rolling stock (or specify its name in the search line) and press OK.
The program will show the measurement scheme and parameters for the

selected rolling stock.

Next, select and connect the gauge: IKP, IDK or IMR. The connection procedure
is described in the previous paragraph.

When the connection is established, the Measurement button will be active and
you can start measurements.
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Designations and buttons:

an ordinal number of the car to be measured (number of cars in the rolling
stock)

pass to the previous/next wheel

pass to the previous/next car

a measured wheel

a wheel to be measured the next time

a non-measured wheel 

parameters of the measured wheel are beyond the tolerances

parameters of the measured wheel are close to the tolerances

measurement

30.3.2.1.     Measurement

· Press the Measurement button in order to measure the wheel offered by the
program (highlighted in green). The laser module will scan the wheel surface. 

· Upon completion of the scanning process, the program will show the values of
selected geometrical parameters.  
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When the value is beyond the tolerances, it will be highlighted in red:

The program allows to display only parameters of the measured profile. To hide
the reference values, you need to disable the Show Reference option (select "Off").

· To repeat the measurement, press the Measurement button.
· When a satisfactory result is obtained, press the Save button to save it.
· The program will offer to pass to the measurement of the next wheel in

accordance with the selected scheme of measurement.
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· To view the results of previous measurements, you can use the arrows. If you
select the measured wheel, the program will display the saved wheel
parameters.

· When you measure the wheel that was already measured, the program
prompts you to replace the existing values with the new ones.

The measurement results can be saved in the WMC fromat. Each measurement
is saved in a separate file. The path:

С:\Riftek LLC\Ikp5_Tablet\Measurements\WMC\HM780_20170830\
Where HM780_20170830 is the directory name, HM780 is the rolling stock

name, 20170830 is the date of measurement (yyyymmdd).
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30.3.2.2.     Measuring by IDK, IMR

To measure the wheel diameter and back-to-back distance, disconnect from IKP
by pressing the Disconnect button, and select the gauge you need: IDK (to measure
the wheel diameter), or IMR (to measure the back-to-back distance).

The measurement process is similar to IKP.
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The measurement results can be saved in the WMC format. Each measurement
is saved in a separate file.

30.3.3.     Automated measurement

The Automated Measurement mode as well as the Simple Measurement
mode allows to perform measurements in accordance with the rolling stock parameters
(scheme, tolerances, reference).

The only difference is that the list contains only those rolling stocks, the
measurement results of which will be imported to the AURA database (the Send to
AURA column is ticked).

Attention! The Internet connection is required in order to connect to the AURA database and
to transmit data.

The measurement procedure has one difference from the Simple Measurement
mode. In order to import data to the AURA database, it is necessary to measure all cars
of the selected rolling stock according to the measurement scheme. Only in this case
the Send to AURA button will be active.
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After pressing the Send to AURA button, the data transmission window appears.
In case of successful identification in the AURA system, the data transmission starts.

When the data is successfully transferred, the following message appears:
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If any error occurs while connecting to the AURA system (for example, if there is
no Internet connection), the error message appears.

In this case, you need to check the Internet connection and try to transmit data
again by pressing the Try Again button. 

To avoid the data loss, all measurement results are also copied to the directory:
С:\Riftek LLC\Ikp5_Tablet\Measurements\ AURA\4002_20170830\
Where 4002_20170830 is the directory name, 4002 is the rolling stock name,

20170830 is the date of measurement (yyyymmdd).

31.     Warranty policy
Warranty assurance for the Laser Profilometer – 24 months from the date of

putting in operation; warranty shelf-life – 12 months.

32.     List of changes

Date Revision Description

17.05.2017 1.0.0 Starting document.

10.11.2017 1.1.0 Added Annex 4 "Software application for working with the A.U.R.A. Wheel
system".

14.01.2024 2.0.0 Describes how to work with an Android device.
The laser module options have been clarified.
Hollow measurement principle clarified.
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optocom@tm.net.my
www.optocom.com.my

mailto:steelwheel@steelwheel.fi
http://www.teraspyora.fi/
mailto:technique@blet-mesure.fr
http://www.blet-mesure.fr/
mailto:disynet@sensoren.de
http://www.sensoren.de/
mailto:finger@finger-kg.de
http://www.finger-kg.de/
mailto:info@althen.de
https://www.althensensors.com/de/
mailto:biuro@ascorail.pl
mailto:export@ascorail.pl
http://www.ascorail.pl/
mailto:milan@influxtechnology.com
mailto:support_india@influxtechnology.com
https://www.influxtechnology.com/
mailto:tanuj@paragoninstruments.com
http://www.paragoninstruments.com/
mailto:management@ptdbs.co.id
mailto:nissodekaloltd@outlook.com
http://www.fly-supply.net/
http://www.aircraft-partsupply.com/
mailto:fae@fae.it
http://www.fae.it/
mailto:f_kuribayashi@tokyoinst.co.jp
http://www.tokyoinst.co.jp/
mailto:foodlab.ee@gmail.com
mailto:sales@althen.nl
mailto:info@althen.nl
http://www.althensensors.com/
mailto:optocom@tm.net.my
http://www.optocom.com.my/
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MONTENEGRO

ASCO RAIL sp. z o.o.
EXCLUSIVE REPRESENTATIVE
FOR RAILWAY EQUIPMENT
ul. Wielowiejska 53, 44-120
Pyskowice, Poland
Tel: +48 32 230 45 70
Fax: + 48 32 233 21 34
biuro@ascorail.pl
export@ascorail.pl
www.ascorail.pl

NETHERLANDS

Althen Sensors & Controls
BV
Verrijn Stuartlaan 40, 2288 EL,
Rijswijk, Leidschendam
The Netherlands
Tel: +31 0 70 392 4421
Tel: +31 0 61 396 7830
Tel: +31 0 64 323 8393
sales@althen.nl
info@althen.nl
www.althensensors.com

NORWAY

BLConsult
Ryssbält 294,
95 291 Kalix, Sweden
Tel: +46 70 663 19 25
info@blconsult.se
www.blconsult.se

NORWAY

Salitec AS
PB 468, N-1327
Lysaker, Norway
Tel: +47 23 891015
Fax: +47 92101005
mail@salitec.no 
www.salitec.no

PERU

Verne Perú S.A.C.
Las Codornices 104, 
Surquillo, Lima, Peru
Tel/fax: +51 992436734
info@verne.cl
www.verne.cl

POLAND

ASCO RAIL sp. z o.o.
EXCLUSIVE REPRESENTATIVE
FOR RAILWAY EQUIPMENT
ul. Wielowiejska 53, 44-120
Pyskowice, Poland
Tel: +48 32 230 45 70
Fax: + 48 32 233 21 34
biuro@ascorail.pl
export@ascorail.pl
www.ascorail.pl

POLAND

RIFTEK EUROPE sp. z o.o.
ul. Domaniewska 17/19, 02-672
Warsaw, Poland
info@riftek.com
www.riftek.com

PORTUGAL

Campal Inovacoes
Ferroviarias Lda.
Lagoas Park, Edifício 7, 1° Piso
Sul, 2740-244 Porto Salvo, Oeiras,
Portugal
Tel: +351 21 584 4348
campal@campal.pt
www.campal.pt

SERBIA

ASCO RAIL sp. z o.o.
EXCLUSIVE REPRESENTATIVE
FOR RAILWAY EQUIPMENT
ul. Wielowiejska 53, 44-120
Pyskowice, Poland
Tel: +48 32 230 45 70
Fax: + 48 32 233 21 34
biuro@ascorail.pl
export@ascorail.pl
www.ascorail.pl

SLOVAKIA

ASCO RAIL sp. z o.o.
EXCLUSIVE REPRESENTATIVE
FOR RAILWAY EQUIPMENT
ul. Wielowiejska 53, 44-120
Pyskowice, Poland
Tel: +48 32 230 45 70
Fax: + 48 32 233 21 34
biuro@ascorail.pl
export@ascorail.pl
www.ascorail.pl

SLOVENIA

ASCO RAIL sp. z o.o.
EXCLUSIVE REPRESENTATIVE
FOR RAILWAY EQUIPMENT
ul. Wielowiejska 53, 44-120
Pyskowice, Poland
Tel: +48 32 230 45 70
Fax: + 48 32 233 21 34
biuro@ascorail.pl
export@ascorail.pl
www.ascorail.pl

SOUTH KOREA

BS Holdings
B-201,Wonpogongwon 1ro, 
59 Danwon-gu, Ansan-si,
Gyeonggi-do 15455, Republic of
Korea
Tel: +82 31 411 5011
Fax: +82 31 411 5015
bsh5011@hanmail.net
www.lasersolution.co.kr

SOUTH KOREA

PROSEN. CO., LTD
M-1001, Songdo techno park IT
center, 32, Songdogwahak-ro,
Yeonsu-gu, Incheon, 21984,
Republic of Korea
Tel: +82 32 811 3457
Fax: +82 32 232 7458
trade@prosen.co.kr
www.prosen.co.kr

SPAIN

IBERFLUID Instruments S.A.
C/ Botanica, 122, 08908
L'Hospitalet de Llobregat
Barcelona
Tel: +34 93 447 10 65
Fax: +34 93 334 05 24
myct@iberfluid.com
www.iberfluid.com

SWEDEN

BLConsult
Ryssbält 294,
95 291 Kalix, Sweden
Tel: +46 70 663 19 25
info@blconsult.se
www.blconsult.se

mailto:biuro@ascorail.pl
mailto:export@ascorail.pl
http://www.ascorail.pl/
mailto:sales@althen.nl
mailto:info@althen.nl
http://www.althensensors.com/
mailto:info@blconsult.se
http://www.blconsult.se/
mailto:mail@salitec.no
http://www.salitec.no/
mailto:info@verne.cl
http://www.verne.cl/
mailto:biuro@ascorail.pl
mailto:export@ascorail.pl
http://www.ascorail.pl/
mailto:info@riftek.com
http://www.riftek.com/
mailto:campal@campal.pt
http://www.campal.pt/
mailto:biuro@ascorail.pl
mailto:export@ascorail.pl
http://www.ascorail.pl/
mailto:biuro@ascorail.pl
mailto:export@ascorail.pl
http://www.ascorail.pl/
mailto:biuro@ascorail.pl
mailto:export@ascorail.pl
http://www.ascorail.pl/
mailto:bsh5011@hanmail.net
http://www.lasersolution.co.kr/
mailto:trade@prosen.co.kr
http://www.prosen.co.kr/
mailto:myct@iberfluid.com
http://www.iberfluid.com/
mailto:info@blconsult.se
http://www.blconsult.se/
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SWEDEN

Kvalitest Industrial AB
EXCEPT FOR RAILWAY
INSTRUMENTS
Ekbacksvägen 28,
16869 Bromma, Sweden
Tel: +46 0 76 525 5000
sales@kvalitest.com
www.kvalitest.com
www.kvalitest.se

SWITZERLAND

ID&T GmbH
Gewerbestrasse 12/a
8132 Egg (Zurich), Switzerland
Tel: + 41 44 994 92 32
Fax: + 41 44 994 92 34
info@idtlaser.com
www.idtlaser.com 

THAILAND

Advantech Solution Co., Ltd.
20/170 Motorway Rd.,
Kwang Pravet, Khet Pravet,
Bangkok, Thailand 10250
Tel: +662 1848705
Fax: +662 1848708
sales@advantechsolution.com
www.advantechsolution.com

TURKEY

MAK Elektronik Malzeme
Analiz ve Kalite Kontrol
Cihazlari Dis Tic. Ltd. Sti.
Cenap Sahabettin Sokak, No:39,
34718 Kosuyolu - Kadikoy /
Istanbul - TURKEY
Tel: +90 216 402 10 34
Fax: +90 216 402 10 35
ulastac@metalografi.net
www.makelektronik.com.tr

TURKEY

TEKMA Mühendislik A.S.
Cevizli Mh. M. Kemal Cd., 
Hukukçular Towers, 
A-Blok, No: 66-A/39
Kartal - Istanbul
Tel: +90 216 970 1318
Tel: +90 850 840 2334
info@tekma.eu
www.tekma.eu

UKRAINE

KODA
Frunze st. 22, 61002,
Harkov, Ukraine
Tel/Fax: +38 057 714 26 54
mail@koda.com.ua
www.koda.com.ua

UNITED KINGDOM,
IRELAND

Althen UK
Northamptonshire
United Kingdom
Tel: +44 0 7823 921427
t.stoyles@althen.co.uk
www.althensensors.com
www.althencontrols.com

USA

Althen Sensors & Controls
2531 Bradley St., Oceanside, CA,
92056, USA
Tel: 858 633 3572
r.ream@althensensors.com

USA, CANADA, MEXICO

Acuity Products of Schmitt
Industries, Inc.
2765 NW Nicolai Street
Portland, OR, 97210, USA 
Tel: +1 503 227 7908
Fax: +1 503 223 1258
sales@acuitylaser.com 
www.acuitylaser.com

USA, CANADA, MEXICO

International Electronic
Machines Corporation
RAILWAY INSTRUMENTS ONLY
850 River Street, Troy,
New York, USA
Tel: +1 518 268-1636
Fax: +1 518 268-1639
marketing@iem.net
www.iem.net

34.     RIFTEK’s measurement instruments for railway
transport

Railway wheel profile gauge, IKP Series

Laser Profilometer IKP-5 Series is employed for:
· Measuring geometrical parameters of the wheel

flange (thickness, slope, height), rim/tire thickness.
· Taking full profile of the wheel rolling surface.
· Maintaining the wear database.
· Tolerance control and sorting when checking,

inspecting, repairing and forming railway wheelsets.
Measurements are made directly on the rolling stock
without rolling out the wheelset.

mailto:sales@kvalitest.com
https://www.kvalitest.com/
https://kvalitest.se/
mailto:info@idtlaser.com
http://www.idtlaser.com/
mailto:sales@advantechsolution.com
http://www.advantechsolution.com/
mailto:ulastac@metalografi.net
http://riftekby.vh120.hosterby.com/where-to-buy/www.makelektronik.com.tr
mailto:info@tekma.eu
http://www.tekma.eu/
mailto:mail@koda.com.ua
http://www.koda.com.ua/
mailto:t.stoyles@althen.co.uk
http://www.althensensors.com
http://www.althencontrols.com
mailto:r.ream@althensensors.com
mailto:sales@acuitylaser.com
http://www.acuitylaser.com/
mailto:marketing@iem.net
http://www.iem.net/
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Rail profile measurement gauge, PRP Series

The main functions of PRP are as follows:
· Obtaining information on the cross-section profile of

the railhead acting face.
· Full profile scanning and analysis of the railhead

acting face.
· Visualization of combined graphic images of the

actual and new cross-section profiles of the railhead.

Wheel diameter measuring gauge, IDK Series

Electronic gauge is designed to measure the wheel rolling
circle diameter of railway, metro and tram wheelsets. 
Measurements are made directly on the rolling stock
without rolling out the wheelset.

Back-to-back distance measuring gauge, IMR Series

Electronic gauge is designed to measure the back-to-back
distance of railway, metro and tram wheels in the course of
checkup, examination, repair and formation of wheelsets.
Measurements are made directly on the rolling stock
without rolling out the wheelset.

Back-to-back distance measuring gauge, IMR-L Series

Electronic gauge is designed to measure the back-to-back
distance of railway, metro and tram wheels in the course of
checkup, examination, repair and formation of wheelsets.
Measurements are made directly on the rolling stock
without rolling out the wheelset.
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Disc brakes profile gauge, IKD Series

Electronic gauge is employed for laser scanning and
measurement of disc brakes wear parameters.
The main functions of IKD are as follows: 

· Obtaining information on the profile of the disc
brakes acting face. 

· Full profile scanning and analysis of the disc brakes
acting face.

· Visualization of combined graphic images of the
actual and new disc brakes profiles.

Real-time wheels geometry measurement system
3DWheel

The system is designed for non-contact automatic
measurement of geometrical parameters of railway wheels
and uses a combination of 2D laser scanners mounted
wayside in the track area.
The system can be easily installed on any type of railway
infrastructure.
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